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   Part I:Introduction 

Socio-economic survey tools are means designed to collect information on 
local resource management systems, resource use and the relative 
importance of resources for households and villages. Surveys also provide 
information on local interaction with the government decision-making 
systems and community perceptions of trends and priority issues 
regarding the conservation and establishment of protection forest. 
Knowledge about community-based institutions, which is also obtained, 
and their roles in the sustainable use and conservation of natural 
resources. 
 
 

Aims of this manual 
 
This manual aims to provide practical steps for researchers conducting 
socio-economic studies among households in communities and villages. 
The techniques involved are rapid rural appraisal, survey research and 
field research.  
 
This manual is accompanied by three supporting notes which are essential 
tools as a basis for gathering socio-economic information. The results can 
be used as input to management and decision-making. 
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Part II: Undertaking socio-economic  
              surveys 

Step 1 – Survey design, sampling and data 
                 requirements 
 
When conducting a survey, the first step is to determine the 
objective and purpose of the survey. This will provide the 
framework for the content and scope of the survey work. It is  
used to help identify the types of stakeholders and 
communities to be surveyed. 

Step 1:  
Designing the survey 
•Design 
•Sampling 
•Sample size 
•Baseline data 

Step 2:  
Planning 
• Scheduled survey 
• Training   
   enumerators 
 

Step 3:  
Implementation 
• Rapid rural appraisal 
       - interview informant 
       - group discussion 
• Households survey 
 

There are three (3) main steps in developing and 
implementing the socio-economic  survey.  
 
The first step is designing the survey, which includes survey 
design, sampling techniques and sample size, data 
requirement (types of data and data collection), target sample 
and questionnaire design. The next step is planning the 
survey. It involves scheduling the survey and training the 
enumerators. Enumerators must be trained to ensure that 
they fully understand and able to pose the questions to the 
respondents. The last step is implementation stage. This 
crucial stage involves key informant interviews, household 
surveys and focus group discussions.  
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Data requirements and survey design 
 
Types of data: There are two types of data to be collected, namely primary 
data and secondary data. Primary data collection involved rapid rural 
appraisal, individual and group discussion, as well as household survey. 
Secondary data comprises information gathered from published media such 
as books, articles, journal, and reports.  
 
Data to be collected: The data required from the study area may be 
discussed with informants and communities. The discussion helps in 
planning the actual survey, improving the questions asked, formulating 
questionnaire design, determining sampling techniques and conducting the 
survey. 
 
 
 
 
 
 
 
 
 
The data gathered through the survey process will need to reflect the 
purpose of the study. In developing the survey, other considerations are 
budget available, the length of time for the interview, availability of human 
resources needed to effectively conduct the surveys, entering the data and 
analyzing the results.  
 

Introduction of the project to local people: A researcher must create good 
rapport with relevant government agencies and local people during initial 
site visit.  
 
The first step to meet related local government officers to explain the 
nature of the study.  
 
This is followed by meeting village headmen, village representatives and 
villagers living in the surrounding area. In many cases, it will be necessary 
to contact the local community leaders before visiting. An introductory 
meeting may also be organized. 
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Who should be included in the survey(s)? 
 
The individuals and communities to be surveyed should be 
decided when considering the objectives and purpose of the 
survey. Different individuals or groups of individuals will be 
interviewed depending on the data needed. For a household-
level survey, a representative of the household should be 
interviewed, but the village head or traditional local leader 
will be interviewed in a key informant interview. Usually key 
informants involved are from Village Development and 
Security Committee or Jawatankuasa Kemajuan dan 
Keselamatan Kampung (JKKK).  Focus group discussions will 
include members of the community.  

Sample size and sampling technique 
 
Sample size: Determining the size of sample is important to 
ensure the data reliability. The sample size needs to be 
sufficient to ensure that the survey results will be 
statistically relevant. However, in many cases, the sample 
size also has to be balanced with the available resources – 
financial, human and time.  

Researchers must briefly introduce and explain the aim of the visit 
and study. It is important to ensure that both local people and the 
researchers/study team understand which area will be studied. The 
aim of research/study must also be clearly introduced to avoid 
misunderstandings or raise false expectations. Cooperation and 
support from local people are essential to ensure successful 
implementation of the study. It is easier to achieve this support if the 
first impression is good. Nevertheless, it must be stressed that the 
fieldwork consists only in data collection and does not promise 
something such as local development project. 
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The bigger sample size require more enumerators and high cost, however 
the correct techniques to estimate the sample size will give more reliable 
results. In general, Roscoe (1992) proposed rule for determining the 
sample size is "greater than 30 and less than 500" as sufficient for most 
research. Further guidelines specified by Calia and Strazzera (1998) in 
their studies of bias and efficiency evaluation model, he defines "small 
sample size" as a sample of 100 or less; sample sizes 250-400 as "moderate 
sample size", and more than 1000 as "large sample size". They concluded 
that even for moderate sample size, most of the evaluation model provides 
good performance and adequate for the estimation of the parameters to be 
measured. This socio-economic study applied formula from Yamano (1985) 
in Supporting Note 1. 

Sampling technique: Random sampling is used to ensure that the sample 
is representative of the study area, while avoiding bias in the results and 
ensuring that all elements of the population have an equal chance of being 
interviewed. There are a number of approaches to determining a random 
sample, e.g. simple random sample, systematic, stratified and clusters.  

Types of questions 
 
For all interview types (household interviews, focus groups and key 
informants), questions can be structured and asked as open, closed or 
partially open questions. The type of question used will depend on the 
information required. There are advantages and disadvantages of all 
question types (Supporting Note 2).  
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Through an open question, such as ‘Does the existence of national 
parks have an impact on your daily life; either positive or negative 
effects’? The interviewer can uncover the meaning behind an answer, 
allowing respondents to provide examples and explain their answers. 
These types of questions are more time-consuming to recode and 
analyze. Open questions can be difficult to ask and interpreting the 
responses could be complex, so training enumerators is essential.  

A partially open question requires the respondent to 
elaborate on any answer given. The advantages of these 
questions are that they are quicker and easier to ask and to 
analyze than open questions, but the interviewer may miss 
some information because of the lack of an appropriate 
category or the level of detail in the response. To avoid these 
problems, the respondents’ answers should be recorded in 
full, and the interview should repeat the question if the 
respondent has not answered sufficiently. Closed questions, 
such as multiple choices or yes/no answers are used when 
key information is required, without the need for further 
explanation or in-depth understanding of the answer or 
issue. These questions are quick to ask and to analyse; 
however, the answers may result in a lack of depth and 
clarity. The example of closed question ‘Are you aware with 
the existence of national park at the adjecent of your village?’. 

Step 2 – Planning and training 
                 the team 
 
A well-trained and experienced team is 
essential for the success of any socio-
economic survey. Previous practical 
experience is a great asset to the team, with 
relevant technical knowledge in socio-
economics, forestry and natural resources. 
For purpose of this study, the research team 
appointed enumerators which have at least 
diploma certificate and preferably 
graduates.  
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All members of the team will require rigorous and robust training in all 
types of survey (household, focus groups, and key informant interviews) to 
be conducted. They should have a thorough understanding of the aims of 
the work and the meaning of every question to be asked. A combination of 
workshop and practically field-based training will provide the best 
understanding of survey methods and procedures. During workshop, the 
objectives and research background are introduced to the enumerators. 
Basic information and knowledge about research is also explained in the 
workshop. This will enhance the communication skills and ability of 
enumerators to interview during data collection or survey. Other than that, 
some basic soft skill and techniques such as communication are also  taught 
in the workshop. In addition, field training is very useful for checking the 
survey questions and means of data collection, thus providing an 
opportunity to make any necessary revision to the survey, interview 
questions and procedures. (Supporting Note 3) 

Consideration should also be given to the 
division of tasks between team members –
team leader and interviewers. Preparation 
(designing the survey work, training the 
team, etc.) and scheduling the survey work 
are essential for a successful survey 
(Supporting Note 4). Preparation of the 
survey team and agreeing on the work plan 
and time frame for completing the surveys 
should be finalized in advance. Villages 
should be given due notification prior to 
survey work and permission to conduct 
interviews should be sought and granted. 

Step 3 – Implementation 
 
Survey approaches vary. Different approaches are used for different 
purposes. For the purpose of the socio-economic study, three survey 
methods are used: 

 Rapid Rural Appraisal includes 
-Community meeting 
-Key informant interview 
-Group discussion 

 Household survey 
 Field research 

 
 

8 



Rapid Rural Appraisal 
 
The methods used include group discussion, community meetings, 
key informant interviews, mapping, ethno-histories, stories and 
taking-note. This RRA technique is a tool that enables a quick 
assessment of the existing environment and the possible impacts of 
the forest resource utilization and the other environmental services 
to the local socio-economic livelihood. Information collected during 
the RRA includes population size, socio-economic activities, 
household dependency on the forest resources and related issues 
faced by the community. This technique can be applied as a 
preliminary stage of the study, which will provide basic information, 
and ethno-histories of the study site for baseline in questionnaire 
design. 

Community meeting 
 
A community meeting is a valuable and 
useful way for the survey team to meet up 
with the villagers, explain the survey work – 
its aims and approach – and ensure that all 
members of the community understand the 
expected outcomes of the survey work 
(Supporting Note 5). A decision to conduct a 
community meeting should be made only 
after meeting the community or village head. 
If possible, the village head could then help 
set up and conduct the community meeting. 
Information related to the community such 
as village profile could be obtained through 
District Office.  

Key informant interviews 
 
Key informants are individuals who are deemed to have knowledge of 
particular issues. Key informants will provide the interview team with 
detailed information and, importantly, interpretation of key issues that 
other members of the community might not be able to provide. Potential 
key informants should be selected, in consultation with the village head, 
traditional local leader, for an in-depth interview with the survey team. 
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Group discussion 
 
Group discussion involves selecting a small knowledgeable  individuals from the 
community. In this study, the group discussion is conducted by researchers to 
explain the study and obtain comments or reactions of the respondents. The 
contribution of focus group is to design and assist questionnaire preparation. 
Focus group analysis is used to identify the issues to be raised in the 
questionnaire such as land use and forest dependency. 
 
The draft questionnaire prepared could be tested in the focus group. Focus group 
thus helps to formulate the questions in simple language and easily understood.   

Household survey 
 
Village and household survey is used 
predominantly to collect quantitative and 
qualitative data, through structured 
interviews with the head of the 
household, using both closed and open 
questions. Survey forms for both 
household- and village-level surveys are 
designed to gather specific information, 
relevant to the survey objective, as 
discussed above. 

Field research 
 
Field research includes methods of research sometimes referred to as 
participant observation, direction observation and case studies.  This 
technique provides qualitative data: observations not easily reduced to 
number.  It enables better understanding on the socio-economic conditions 
and activities of villagers such as paddy farming, harvesting and marketing 
of forest resources. Case studies involved the narration of typical 
experience of villagers in relation to the utilisation of forest resources. The 
data gathered are used to cross-check information collected from the 
survey. 
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The questionnaire 
 
In conducting this study, the formation of the questionnaire is the most 
important component. Formation of the questionnaire is based on the initial 
survey (Rapid Rural Appraisal) to the study area and also by the results of 
the initial questionnaire test in focus group. Formation of the questionnaire 
usually is categorized based on types of questions to gather basic 
information such as demographic background, perceptions and level of 
involvement. Example of questionnaire is attached in Supporting Note 6. 

Part III: Using the data collected 

Analysis and use of the collected data should reflect the 
objectives of the survey. 
 

Data analysis 
 
The choice of method for data analysis will depend on the 
volume of data collected, the expected use of the findings and 
the availability of the analysis software. 
 
Analysis of the data is usually done in a statistical package 
such as SPSS (Statistical Package for the Social Sciences) 
software. SPSS is a widely used program for 
statistical analysis in social science. It is also used by market 
researchers, health researchers, survey companies, 
government, education researchers, marketing 
organizations, data miners and others. Using such packages 
also allows the data to be entered and cleaned before 
analysis. Data may be exported to other software packages 
such as Microsoft Excel for further analysis and for 
preparation of tables and graphs. Some of the analysis that 
could be used are Descriptive analysis; Regression; 
Correlation; Anova and etc. (Supporting Note 7) 
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R-software: The new well-known statistical software available free online is 
R. R is a language and environment for statistical computing and graphics. 
R provides a wide variety of statistical (linear and nonlinear modelling, 
classical statistical tests, time-series analysis, classification, and clustering) 
and graphical techniques, and is highly extensible. One of R's strengths is 
the ease with which well-designed publication-quality plots can be 
produced, including mathematical symbols and formulae where needed. 
(Supporting Note 8) 

The final analysis will need to reflect the original aims and objectives 
of the survey. To help structure the analysis, research questions could 
be developed, such as: 
 

 How important is access to forest resources for the livelihoods of communities? 
 To what extent, the communities depend on forest resources for the economic 

activities? 
 Are the poorest communities more dependent on forest resources than other 

groups? 
 How does the establishment of protected area affect the livelihoods of 

communities? 
 What are the dependent communities’ perceptions of ecotourism at the 

protected area (National park)? 
  What is the relationship between communities and natural resources? 
  What is the distribution of socio-economic impacts at the area, and what are the 

sources of leakage? 
  What benefits have been foregone to surrounding communities with the 

establishment of protected area (National Park)?  
  What are the social implications, particularly for indigenous people & local 

communities, associated with the management system of protected area? 
  What strategies could be used to strengthen the ecotourism-environment-

community relationships at the area that was gazetted as protected area? 
12 
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Note 1 – Sampling techniques 
 
Determining a sample size 
 
The appropriate sample size ultimately depends on the purpose of the 
study. For example, a population census will require 100% participation, 
and hence the sample size must equal 100%. Factors such as the available 
resources (time, budget, human) will affect the sample size but care should 
be taken not to jeopardize the statistical relevance of the sample. 
  
Determination of sample size is important in determining the accuracy of 
the estimated value of the findings. A larger sample size implies more 
enumerators and involves high costs, but at the same time the sample size 
was chosen correctly, will give greater accuracy estimates.  
 
Example of sample size determination by Yamano (1985) is as follows: 

        n  =      N 

             1+N (e) 2 

 

= 1136___ 

       1+1136 (0.05)2 

 

    = 400 respondents 
 

 Where,  

  n = Sample Size 

  N = Population Size (No. of households) 

  e   = level of precision 

 

From the above example of sample size, taken at the level of precision of 

5% or 0.05. The results showed that the sample size of 400 respondents is 

the reliable sample size.  

 

 

 

 



14 | P a g e  

 

Note 2 – Format of questionnaire 
 

When designing a survey and conducting an interview, it is important to 
consider how a question can be structured, that is, whether it should be 
open or closed, or a mixture of both. The type of question and way that it is 
asked will affect the answer provided. 
 
In general, questions can be either open or closed. The main difference 
between these two types of question is that open questions allow 
respondents to explain their answers, whereas closed questions do not. 
With closed questions, respondents do not have the freedom to give an 
answer other than those provided in the list of questions. Partially open 
questions can also be used when conducting socio-economic surveys. 
 
A survey/questionnaire will use a range of question types to ensure that 
the information is obtained in the most appropriate manner. 
 

 
Open questions 
 
Open questions – example from socio-economic study in 2014 
 

”Does the existence of national parks have an impact on your 
daily life?” 

  
“In your opinion, is the conservation of forest/natural resources 
important?” 

 
Open questions provide no options for possible prompts or answers and 
the respondent is able to answer completely freely. However, respondent 
answer might be long and enumerators must be well-trained to capture 
and get the points. Open-ended questions have both advantages and 
disadvantages (Table 1). 
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Table 1. Advantages and disadvantages of open questions 

 

Advantages Disadvantages 

 The interviewer can elicit more 
information and possibly uncover 
new information that had not 
been previously considered. 

 The interview records can be used 
in the report as interesting 
illustrations. 

 The responses provide additional 
scope for analysis and allow a new 
interpretation of the conclusions. 

 The interviewer needs to have 
experience to build discussion of 
particular topics and record the 
findings. 

 Data analysis requires expertise 
and a lot of time. 

 

To mitigate the disadvantages of open questions, those conducting the 
survey or interview can: 
 

 Train interviewers and provide direction for ongoing tasks to 
improve the quality of the data collected. 

 Prepare a list of questions that allow interviewers to systematically 
explore the respondents’ answers. 

 Use open questions in training sessions with the team members. 
 

 

Partially open questions 

 

Partially open question – example from socio-economics study in 2014 

 

“In your point of view, the existence of protection forest 

(National Park) is something good or vice versa” 

a) Good, because...... 

b) Not good, because....... 

 

In a partially open question, the answer is available as part of s category. 

Hence, the respondent is given a choice of responses: in the example above, 

the response is either ‘increased’ or ‘decreased’ (closed), “good” or “not 

good”, and “yes” or “no” but the respondent is given the opportunity to 
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explain his or her answer provided using ‘because …’ (open). This type of 

question also has advantages and disadvantages, as set out in Table 2. 

 

Table 2. Advantages and disadvantages of partially open questions 

 

Advantages Disadvantages 

 Easy answers and 

quick note-taking 

 Easy analysis 

 Important answers could be missed if 
there is no appropriate category 
provided. 

 Some information may be forced into 
existing categories and other 
information might be lost. 

 If respondents hesitate and the 
interviewer helps with grid answers, the 
results are potentially biased. 

 

To mitigate the disadvantages of partially open questions, those conducting 
the survey or interview can: 

 Record all answers by taking notes or using a voice recorder. 
 If respondents do not give an answer, repeat the question in a 

different way but without leading the respondent to an answer. 
 

Closed questions 

 

Closed questions –example from socio-economic study in 2014 

View on the effects of Land 
Development Planning 
toward: 

Strongly disagree   Disagree   Neutral   Agree   Strongly agree 

(1)                     (2)            (3)         (4)                (5) 

There is an increase of 
social problems in the local 
community 

 

Development project 
generates income 
households 

 

Development project helps 
participants / households 
out of the poverty situation 

 

 

 
 



17 | P a g e  

 

 
With closed questions, respondents must choose one of the available 
answers, and no room is provided for further explanation or elaboration. 
Using closed questions is useful when time is short and very specific 
information is required. Usually in this type of question use Likert Scale as 
baseline for questionnaire. 
 
Again, this type of question has advantages and disadvantages, as detailed 
in Table 3. 
 

Table 3. Advantages and disadvantages of closed questions 

 

Advantages Disadvantages 

 Answers can be quickly 
gathered, thus saving time. 

 Comparison of respondents’ 
and groups’ answers over time 
is easy. 

 Further analysis of closed 
questions can be difficult 
because of the lack of 
supplementary questions for 
respondents to elaborate on 
the reasons for their answer. 

 

To avoid the disadvantages of this type of question, the interviewer could 
ask further questions to explore respondents’ answers in more depth. 
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Note 3 – Do & Don’t in Conducting Socio-Economic  
                  Interviews 
 

Do 

1. Understand the projects background and objectives 

2. Aware of questionnaire contents 

3. Beware of languages 

4. Proper attire or dress code (Formal, casual but most important neat, 

and clean) 

5. Always SMILE 

6. Use suitable, understandable and simpler words (layman terms) 

7. When asking a question: 

a. Speak when respondent ready 

b. Control volume of voice 

c. Greet sincerely 

d. Introduce yourself, show name tag with organization logo  

e. Explain the purpose of the survey 

f. Explain the importance of study 

g. Inform respondent that information given is confidential 

h. Ask only related question 

8. Use supporting tools such as Likert Scale Card, Pictures, etc. 

9. Be a good listener 

10. Ask for permission before taking photo 

11. Give a door gift as token of appreciation 

12. End interview session with THANK YOU 

 

Don’t 

1. Don’t ask question if the respondent is not ready 

2. Don’t ask respondent’s full name, to avoid respondent feeling 

uncomfortable 

3. Don’t force if people do not want to be interviewed, especially in 

household survey 

4. Don’t take an advantage to look around respondent’s house 

5. Don’t force respondent to get an answer, especially on income. Ask 

politely, instead. 

6. Don’t ask for hand phone number, if not necessary. 
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Note 4 – Conducting the survey 
 

Before undertaking a survey, the following key steps should be followed. 
Step 1: Preparation and scheduling of the survey work 
 

 Preparation and scheduling of the survey work is essential for a 

successful survey 

 The work plan and time frame for completing the surveys should be 

agreed with the team in advance.  

 The roles and responsibilities of each team member should be clearly 

defined.  

 Data sheets and questionnaires must be prepared 

 The team trained 

Step 2: Ask permission and inform about the survey work 

 Ask permission from the village head prior to carrying out any survey 

 Ensure that the village has been informed and permission from the 

village head has been obtained sufficiently in advance of the survey 

 If necessary, write letter to Local Authority (JAKOA, District Office, 

etc.), and Head of Villages 

Step 3: Meeting with community 

 If possible, a meeting with the community or at least the head of the 

village should take place at the start of the survey 

 Introduce the survey team members 

 Clearly and fully explain the survey, its purpose and how it will be 

conducted 
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Note 5 – Guidance for community meetings 
 

Community meetings are vital to the success of surveys and it is important 
to engage communities/villagers. Building community engagement takes 
time and should not be forced or rushed. Socio-economic surveys and 
group discussions, if done correctly, can be a good way to begin building a 
relationship with the community. Often information collected during socio-
economic surveys is personal in nature and even confidential, and it should 
always be handled sensitively. 
 
The guidance below will help to ensure that the community meeting gets 
off to the best possible start. 
 

1. Set the village hall as the meeting place, and schedule the meeting 
with village leaders. 
 

2. Start the meeting by: 
 Introducing all the team members 
 Explain the purpose and background of the study 
 The role of the organization undertaking the survey work 
 Ensure that the outputs of the survey work are clearly 

explained and expectations are realistic 
 Avoid making promises 

 
3. Describe the activities and what will be achieved from this study. 

 What will be provided to the community? 
 How can the community participate? 
 How can the community assist and advise the team 

during the study? 
 

4. Explain to the community 
 The importance of the study’s schedule and activities 
 Check whether there are potential problems or conflicts 

with local activities. Determine an acceptable schedule 
for major activities. 
 

5. Villages participation 
 Invite the villagers to introduce themselves or their 

village. 
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 Find out if villagers have time to participate in the survey 
as needed, and when they have time to do it. 
 

6. Recognize key informant 
 Informal discussions may guide the survey team to 

recognize key informants, especially those who have 
knowledge related to the study. 
 

7. Check whether any community members feel unhappy about the 
proposed activities. If so, explain any specific aspects that they find 
unacceptable. Be willing to accept specific bans and modify the 
approach accordingly. 
 

8. Close the meeting. Start planning survey activities based on the 
available options. 
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Institut Penyelidikan Perhutanan Malaysia (FRIM) 

52109, Kepong, Selangor 
 

Dan 

 

 

 
Forestry and Forest Products Research Institute (FFPRI), Japan 

 

KAJIAN KEPENTINGAN SOSIO-EKONOMI  PENDUDUK TEMPATAN 
SEKITAR KAWASAN HUTAN SIMPAN DAN HUTAN PERLINDUNGAN 

TAMAN NEGARA, MELALUI KEPENGGUNAAN HUTAN SECARA 
LESTARI DAN KONSERVASI 

Socio-economic Study of The Local that Live Near The Adjecent of Forest 
Reserve and National Park Protection Forest Through Sustainable Use of Forest 

and Conservation 
 

Institut Penyelidikan Perhutanan Malaysia (FRIM) bersama Forestry and Forest 
Products Research Institute (FFPRI) Japan sedang menjalankan survei ‘Kajian 
Kepentingan Sosio-Ekonomi Penduduk Tempatan Sekitar Perlindungan Taman 
Negara Melalui Kepenggunaan Hutan Secara Lestari dan Konservasi’. Survei ini 
adalah sebahagian daripada kajian ‘Research on Development of Forest Carbon 
Monitoring Methodologies for REDD+ in Peninsular Malaysia’. Tujuan survei ini 
dijalankan adalah untuk mengumpul maklumat impak sosio-ekonomi penduduk 
tempatan terhadap kepenggunaan kawasan hutan perlindungan Taman Negara.  
Segala kerjasama di dahului dengan ucapan terima kasih. Segala kerjasama di 
dahului dengan ucapan terima kasih. 
 
 
 

Sebarang pertanyaan mengenai kajian ini, sila berhubung dengan Program Ekonomi & Analisa 
Strategik, Institut Penyelidikan Perhutanan Malaysia (FRIM), 52109 Kepong, Selangor, Malaysia. Tel: 
03-62797547/62797000 

                          RES -  

 
 

Note 6 - Questionnaire 
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1. No sampel/ No of sample                               Penemuramah/Interviewer: ______________ 
 
2. Nama Kampung/ Name of village 
 a. Kg. K. Tahan  f. Kg. Gusai 
 b. Kg. Pagi   g. Kg. K. Koh 
 c. Kg. Bantal   h. Kg. Merapoh 
 d. Kg. K.Sat   i. Kg. Gol 
 e. Kg. Merting 
 j. Lain-lain/ (others) __________________________ (nyatakan)/(please state) 
       
A) Penggunaan sumber-sumber dan tanah hutan  oleh ahli-ahli keluarga anda? 
 The usage of natural resources and forest land by you and your family? 
  
1) Tanah untuk bercucuk tanam / Agriculture  1 = Ya/Yes 2 = Tidak/ No 
2) Menangkap ikan/ Fishing    1 = Ya/Yes 2 = Tidak/ No 
3) Memburu binatang / Hunting animal   1 = Ya/Yes 2 = Tidak/ No 
4) Penghasilan pokok herba untuk perubatan    1 = Ya/Yes 2 = Tidak/ No 
 Medicinal plants/herbs for medicine  
5) Penghasilan rotan/ Rattan harvesting  1 = Ya/ Yes 2 = Tidak/ No 
6) Sumber air untuk pertanian/ Water for agriculture 1 = Ya/ Yes 2 = Tidak/ No 
7) Sumber bahan-bahan kraftangan/  Handcraft 1 = Ya/ Yes 2 = Tidak/ No 
8) Penghasilan buah-buahan hutan/ Wild fruits  1 = Ya/ Yes 2 = Tidak/ No 
9) Penghasilan buluh/ Bamboo harvesting  1 = Ya/ Yes 2 = Tidak/ No 
10) Penghasilan madu lebah/ Honey   1 = Ya/ Yes 2 = Tidak/ No 
10) Lain-Lain / Others     
 ______________________________________________________________ 

______________________________________________________________ 

 
B) Sebagai penduduk tempatan, adakah masalah-masalah   yang berikut  
             dihadapi oleh keluarga anda?  
 As local people, do the following problems faced by your family? 
  
1) Masalah hasil hutan yg. Berkurangan/  1 = Ya/Yes 2 = Tidak/ No 
 Decrease in forest products 
2) Masalah kekurangan tanah bercucuk tanam  1 = Ya/Yes 2 = Tidak/ No 
 Shortage of farming land 
3) Kekurangan tenaga pekerja/ Shortage of manpower    1 = Ya/Yes 2 = Tidak/ No 
4) Masalah penyakit tanaman/ Crop diseases  1 = Ya/Yes 2 = Tidak/ No 
5) Hasil tanaman susah untuk dipasarkan   1 = Ya/Yes 2 = Tidak/ No 
 Crop difficult to be marketed 
6) Masalah sistem pengairan untuk tanaman  1 = Ya/Yes 2 = Tidak/ No 
 Problem in crop irrigation system 
7) Larangan menjalankan aktiviti pemungutan 
 hasil hutan      1 = Ya/Yes 2 = Tidak/ No 
 Prohibiton on collecting forest products 
8) Lain-Lain / Others     
 _____________________________________________________________ 
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C) Pandangan terhadap projek konservasi/pemuliharaan Hutan Perlindungan 
Taman Negara / Views on conservation projects/ Conservation of National Park 
Protection Forest 

1. Adakah saudara sedar akan kewujudan persekitaran taman negara 
bersempadanan penempatan saudara?/ Are you aware with the existence of 
National Parks? 

a. Ya/ yes b. Tidak/ No 
 

2.  Adakah kewujudan persekitaran taman negara memberi kesan ke atas 
kehidupan seharian saudara; samada kesan positif atau negatif? / Does the 
existence of national parks have an impact on your daily life; either positive or negative 
effects? 

Kesan-Kesan 
Pembangunan/ 

Impact of 
development 

Sila tanda bahagian yang sesuai/ Please tick 
the suitable part 

Sila catatkan 
keterangan/ 

ulasan yang diberikan 
semasa temubual/ 

Comments 

C21. Kesan-kesan 
positif/ Positive 

impacts 
 

a. Tambah  pendapatan/ Increase income 
b. Tambah pekerjaan/ Employement  
c. Pembangunan tempatan/ Local development 
d. Tempat  pelancongan/ Tourism 
e. Kemahiran berkomunikasi/ Communication 
skills 
f.  Kemahiran berniaga & 
    berurusniaga/ Business skill 
g. Meningkatkan kemahiran kaum 
    wanita – menceburi industri  
    kecil/ Women skill- Small industry 
h. Merperkenalkan kebudayaan  
    setempat/ Cultural 
i. Lain-lain (nyatakan) / Others____________ 

 

C22. Kesan-kesan 
negative/ 

Negative impacts 

a. Gangguan masyarakat luar/ Disturbance from 
the outsider 
b. Kekurangan sumber pendapatan/ lack of 
income resources 
c. Kekurangan tanah untuk pertanian / land 
shortage for agricultural purposes 
d. Kekurangan ruang mencari hasil  
    hutan / prohibition in collecting forest products 
e. Lain-lain (nyatakan)/ others: _______ 

 

 
2. Secara umumnya, apakah pandangan/perasaan saudara mengenai kewujudan 

persekitaran taman negara bersempadanan dengan penempatan saudara; 
adakah ianya sesuatu yang baik atau sebaliknya? 
Generally, what is your views on the existence of a national park environment adjacent to 
your housing areas, is it a good thing or not? 

__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
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__________________________________________________________________________
__________________________________________________________________________ 

 
3. Apakah pandangan saudara mengenai pelancongan/pelancong; dan 

kemungkinan industri ini akan lebih berkembang pada masa hadapan 
khususnya dipersekitaran taman negara ini? 
What is your opinion on travel / tourist; and the industry will be more likely to grow in 
the future, especially on the area nearby the park? 

 ___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________ 

 
5. Adakah aktiviti pemuliharaan sumber hutan/sumber semulajadi sesuatu yang 

penting bagi saudara? Nyatakan: 
     Does forest conservation / natural resources is crucial for you?Please state: 
 ___________________________________________________________________________

___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________ 

 
6. Pada pandangan saudara, dengan berkembangnya industri/aktiviti pelancongan 

setempat; adakah ia akan memberi pulangan/keuntungan atau sebaliknya kepada 
diri saudara sendiri dan juga komuniti secara umum? 

     In your point of view, is the development of industry / local tourist activities will         

     provide a return / profit or otherwise, to your own self and the community in general? 

 
Individu/ Individual 

 
 Positif/Positive               Negatif/Negative 
_____________________________  _____________________________ 
_____________________________  _____________________________ 
_____________________________  _____________________________ 
_____________________________  _____________________________ 
_____________________________  _____________________________ 
_____________________________  _____________________________ 

 

Komuniti/ Community 
 

 Positif/ Positive    Negatif/ Negative 

_____________________________  _____________________________ 

_____________________________  _____________________________ 

_____________________________  _____________________________ 

_____________________________  _____________________________ 

_____________________________  _____________________________ 

_____________________________  _____________________________ 
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7. Adakah pihak berkuasa taman negara melibatkan saudara atau komuniti setempat 
secara langsung dalam pembangunan taman negara diperingkat-peringkat tertentu 
(perancangan, pendidikan, maklumat/informasi & sebagainya? 

     Does the national park authorities involve you or local communities directly in park 
development on specific stages (planning, education, information / information & others? 

 ___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________
___________________________________________________________________________ 

 
D) Pandangan terhadap penggunaan kawasan Hutan Perlindungan Taman 

Negara  dengan bijaksana mengikut keutamaan bagi setiap penggunaan 
seperti yang berikut: 

             Views on the usage of Protection Forest National Park according to   
             priority as follows: 
 

 Pilihan mengikut keutamaan/ 
Choice of priority 

1. Pemeliharaan (Dibiarkan secara semulajadi)/       
    Conservation (Left naturally) 

      1            2            3            4            

2. Pembangunan eko-pelancongan/ Development of  
    eco-tourism 

      1            2            3            4            

3. Pembalakan dan menanam semula dgn sistemetik/ 

Logging and replanting with systematic 
      1            2            3            4            

4. Dibuka semula utk pembangunan  pertanian/    

    Reopened for agricultural development 
      1            2            3            4            

 

 

E) Kedudukan ahli-ahli isi rumah (iaitu ahli keluarga yang tinggal bersama) di 
kampung ini/ The members of the households (ie family members living 
together) in the village. 

 
1. Jumlah ahli keluarga yang tinggal bersama/ Number of family members living   
             together _______________________                  
2. Bilangan ahli keluarga yang bekerja/ Number of family members working   
              ___________________                                         
3. Bilangan ahli keluarga yang bergantung kepada ahli lain/ Number of dependent  
             family member to other members ___________                                  
 4. Bilangan ahli keluarga yang mengganggur/ The number of jobless family members   
              _______________________ 
5. Bilangan ahli keluarga berhijrah/ Number of family members migrated    
              ___________________                        
6.  Bangsa (Sila nyatakan)/Race (please state) _____________________ 
7. Kawasan tanah pertanian dimiliki oleh keluarga/ The area of agricultural land   
             owned by the family :  
 a. Luas tanah asal yang dimiliki / Land area owned _____________________ ekar/   

                 acres 
           b. Jenis tanaman yang diusahakan (Mengikut keutamaan) /Types of crops   
                 cultivated (by priority) 
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 1. Padi/Paddy                2. Getah /Rubber  3. Dusun/Garden    
  
 4. Tnm. Kontan/ Cash crops              5. K. Sawit/ Oil palm  6. Lain-lain 
(nyatakan)/Others (please state) 
           ________________________ 

8. Maklumat tanaman di atas:/ Information on the crop above: 
 

Bil. 
Bil 

Jenis tanaman 
Type of crop 

Luas (ekar) 
Area (acre) 

Umur tanaman 
sekarang 

Age of crop 

1. Padi / Paddy   

2. Getah/ Rubber   

3. Dusun/ Garden   

4. Tanaman kontan/ Cash crops   

5. Kelapa sawit/ Oil palm   

6. Lain-lain (nyatakan)/ Others 
(please state) 

  

    

 Jumlah luas/Total area   
 

 

F) Status pekerjaan ahli-ahli Isirumah yang bekerja  
Employment status of working household member 

 

 

(F1) 
Ahli/ 
Membe

r 
 

(F2) 
Umur

/ 
Age 

(F3) 
Jantina/ 

Sex 
 
1 = L/M 
2 = P/F 

(F4) 
Pencapaian 

Pendidikan
/ 
Education 
achievement  
 
0=Tiada/Non
e 
1=Sek. 
Ren(Primary 
school) 
2=Sek 
Men(Secondar
y school) 
3=Tkt 6(Form 
6) 
4=Kolej & 
U/Collegue & 
U) 

 

(F5) 
Taraf 

Perkahwina
n 

/Status 
 

1=Bujang/Sin
gle 
2=Berkahwin
/Married 
3=Duda/jand
a/Divorced 

(F6) 
Pekerjaan 

Utama 
/Main job  

1= Pencari hasil 
hutan/Seekers 
of forest 

2= Penanam 
padi/Paddy 
farmer 

3= Bertani 
dusun/Garden 

farmer 
4= Penoreh getah 
/Rubber tapper 
5= Penanam sayur 
/Farmer 
6= Pekerja 
kontrak/Contract 
workers 

7= 
Berniaga/Business 
8.= 
Kerajaan/Govern
ment 
 ______________ 
9= Swasta/Private 
 ______________ 

(F7) 
Status 

Pekerjaan 
/Employment 
status 
1=Majikan/ 
Employer 
2=Pekerja/ 
Employee 
3=Kerja 
sdr/Freelance 
 
4=Pekerja    
    keluarga  
    tanpa upah 
/ Employee  
     family  
     without 
wages   

(F8) 

Pekerjaan 

Sekunder 

/Secondary 

employment  

 (sambilan) 

(part time) 



 

28 | P a g e  

 

10= 
Pesara/Retired 
11= Suri 
rumah/Housewife 
12= Lain-
lain/Others 
______________ 

Beker
ja/W
orkin
g 

       

1 
(ketu
a)(Le
ader) 

       

2        

3        

4        

5        

6        

Tak  
Kerja
/Joble
ss 

       

91        

92        

93        

94        

95        

96        

97        

98        

99        

100        

101        

102        
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PENGGUNAAN SUMBER-SUMBER EKOSISTEM HUTAN SIMPAN 
DAN KAWASAN SEKITAR & HUTAN PERLINDUNGAN TAMAN 
NEGARA, 2013 
USE OF FOREST RESERVED ECOSYSTEM RESOURCES AND RESPECTIVE 
AREAS & FORESTS PRESERVED NATIONAL PARK, 2013 
 

G) Penghasilan sumber bukan kayu (Non-timber Forest Products) 
 

1. Jenis hasil /Type of product   1=rotan/Rattan    2=buluh/Bamboo  3=bahan    
             kraftangan /Crafts materials  4=  Keranji /Black velvet 5=petai /Bitter beans 
             6=ubatan/Medicines 7=madu/Honey  8= Lain- lain/others:        
              _______________________ 
2. Tahun berapa terlibat/ Year involved:___________ 
4. Kekerapan masuk hutan (2013)/ Frequency enter forest:    
              _____(trip/bulan)/(trip/month) _____( bulan/setahun) /(month/years) 
5. Jenis spesis yang diambil/ Type of species taken 
 1. Rotan/ Rattan     ___________ ___________ ___________ _____________ 
 2. Buluh/ Bamboo   ___________ ___________ ___________ _____________ 
 3. Bhn. Kraftangan/ Crafts materials   _______ ___________ ___________     
                  _____________ 
 4. Keranji/ Black velvet ___________ ___________ ___________
 _____________ 
 5. Petai /Bitter beans ___________ ___________ ___________ _____________ 
 6. Ubatan/ Medicines ___________ ___________ ___________ _____________ 
 7. Madu /honey   ___________ ___________ ___________ _____________ 
 8. ________  ___________ ___________ ___________ _____________ 
 
6. Maklumat pungutan hasil untuk semua spesis/ Information on revenue of collection    
    for all species 

 

Bil/ 
Bil 

Jenis spesies 
dipungut/ 

Species collected 

Kekerapan 
dipungut 
sebulan/ 
Frequency 
collected in 
the month 

Jumlah hasil 
dipungut per trip 

(nyatakan unit sama 
ada dalam kg, 

bilangan, batang, 
dll)/ 

Total revenue collected 
per trip  

(indicate whether units 
in kg, number, trunk, 

etc. 

Lokasi/ 
Location 

Jarak 
(km)/ 

Distance 
(km) 

 

1. Rotan/ Rattan         

2. Buluh/Bamboo       

3. Bahan 
kraftangan/ 
Crafts materials    

    

4. Keranji/ Black     
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velvet 

5. Petai/ Bitter 
beans 

    

6. Pokok ubatan/ 
Medicine plants 

    

7. Madu/Honey     

      

 
7. Nyatakan alatan yang dibawa/digunakan (kos tetap)/ Specify tools brought / used 

(fixed costs) 
                               (a)                                      (b)                  (c)                     (d) 

                     Jenis alatan/                            Bilangan        Harga beli         Jangkahayat 

 Type of equipment                     Unit               (RM)                  (tahun)                   

                                                                                Price(RM)         Lifespan (years) 

             1. _________________  ___________ __________ _____________ 

 2. _________________  ___________ __________ _____________ 

 3. _________________  ___________ __________ _____________ 

 4. _________________  ___________ __________ _____________ 

 

8. Lain-lain kos terlibat (makanan, kos luar jangka): RM ______________ 
              Other related costs (food, contingency cost): RM _________________ 
 
9. Jumlah pengambilan hasil/trip/bulan (unit)/ 
            Total revenue intake / trip / month (units) 
 1. Rotan/ Rattan      ___________ 2. Buluh/ Bamboo  ___________ 3. Bhn.    
              Kraftangan/ Crafts materials   ______ 
 4. Keranji/ Black velvet ___________ 5. Petai/ Bitter beans ____________ 6.   
             Ubatan/ Medicine ______________ 
 7. Madu/Honey   __________  8. ______________ 9. _______________ 
10. Jenis kenderaan yang digunakan :/ Types of vehicles used 
              ________________________________ 
11. Lokasi pengambilan hasil/ Location of sample taken                                      

                                                               (a)                                                        (b) 
                                    Tempat                       Jarak dr tempat  
                                         (Htn. Simpan, Tnh. Kerajaan,                   tempat tinggal (km) 
                                             T. Negara atau Hakmilik) 
  
                                                           Place 
                       (Conserved Forest,. Government Land             Distance from residence  (km) 
                               Country Land or Preseved Land) 
 
 
 
 
 
             1. Rotan/ Rattan       ___________________________  _____________ 
 2. Buluh/ Bamboo   ___________________________  _____________ 
 3. Bhn. Kraftangan/ Crafts materials   _______________________ 
 _____________ 
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 4.  Keranji/ Black velvet ___________________________ 
 _____________ 
 5. Petai / Bitter beans ___________________________  _____________ 
 6. Ubatan/ Medicine ___________________________  _____________ 
 7. Madu/Honey ___________________________  _____________ 
 8. ________ ___________________________  _____________ 
 9. ________ ___________________________  _____________ 
 
12. Bilangan pekerja yang terlibat untuk satu-satu trip/ The number of employees  
             involved for a trip 
 1. Ahli keluarga/ Family members  ____________________ orang/person 
 2. Bukan ahli keluarga/Non Family members ____________________ orang/ person 
 
13. Jika bukan ahli keluarga berapakah upah yang dibayar untuk satu-satu  
             trip:RM __________________ / seorang 
              Wages paid if not family members per trip : RM __________________ / person  
14. Jangkamasa kerja ketika pengambilan hasil (untuk setiap trip)/ 
             Duration of work during sample collecion  (per trip) 
 1. Masuk hutan (jam) / In forest (hours) _______________ 
 2. Keluar hutan (jam)  Out forest (hours) _______________ 
                                      1=Ya/Yes     2=Tidak/No 
15. Adakah anda memproses sendiri hasil yang diambil: 
             Do you process the result  taken by yourself: 
16. Jika ‘tidak’ dimanakah ianya dijual dan purata harga jualan (ex-farm) 
             If 'no' where is it sold and the average selling price (ex-farm) 
                     (a)                                  (b)                                 (c)                               (d) 
   Jenis NTFP         Lokasi jualan dan jarak      Harga jualan                  Cara 
                                               (Nama syarikat)                   (RM)/unit                   jualan 
 Type of NTFP        Location of sale and distance        Price                     Method of sales 

                                                (Name of company)                 (RM)/Unit 

 

              

             __________ _______________________ ___________ ______________ 

 ___________ _______________________ ___________ ______________ 

 ___________ _______________________ ___________ ______________ 

 ___________ _______________________ ___________ ______________ 

 

17.      Jika dihantar sendiri, nyatakan jenis kenderaan yang digunakan dan  
     jumlah pekerja yang terlibat (16d):/ If delivered by hand, specify type of vehicle used 
and no. of worker involved: 

a. Jenis kenderaan/ Type of Vehicle: ____________________b. __________________ 
orang/person 
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18. Jika ianya diproses sendiri, apakah nama produk yang dikeluarkan:/ If it is 
processed itself, named the products 
 
                              (a)                                          (b)                                              (c) 
                   Nama produk/              Lokasi jualan/ Location              Harga jualan/ Price 
                 Name of Products         (Pasar malam, pasar tani, ..)                  (RM/unit)                             
 1. _______________ ___________________________ _______________ 

 2._______________ ___________________________ _______________ 

 3. _______________ ___________________________ _______________ 

 4. _______________ ___________________________ _______________ 

             

   (d)                         (e)                                             (f) 

 Kekerapan menjual  Jumlah pengeluaran  Jumlah jualan/bulan 

        hari/minggu      unit/bulan             (unit) 

             Selling Frequency  Total production  Total sales/ month 

 ___________________  ____________________ ___________________ 

 ___________________  ____________________ ___________________ 

 ___________________  ____________________ ___________________ 

 ___________________  ____________________ ___________________    

 

(g) 

                Kos pembuatan/ Manufacturing cost 

        (RM/unit) 

 ___________________  

___________________  

___________________  

___________________ 

 

 

H) Penglibatan penduduk dalam aktiviti eko-pelancongan 
 Local involvement in ecotourism activities 

1. Adakah saudara atau ahli keluarga terlibat dalam aktiviti pelancongan 
 Do you or a family member are involved in tourism activities 
 a) Restoran  b) Chalet               c) Homestay 
 d) Kedai runcit/Grocery  e)Pemandu bot/ Boatman 

f) Pemandu pelancong/tourguide 
 g) Lain-lain (nyatakan)Others  ________________________ 
 
2. Adakah terdapat perbezaan dari segi pendapatan isirumah pada tahun 80 

an berbanding sekarang/ Is there a difference in terms of household income in the 80s 
than it is now 

 a1. pendapatan meningkat,Income increase ______ % 
 a2. pendapatan menurun, income decrease  ______ % 
 a3. pendapatan tidak berubah, no changes 
 
3. Adakah berhasrat menceburi bidang yang bersangkutan dengan sektor  

sokongan kepada sektor pelancongan (spt: berniaga kecilan, mengusahakan 
homestay, pemandu pelancong & pembekal)/ Do intend to venture into the field 
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related to the support for the tourism sector (eg: business scale, doing homestays, guides 
& suppliers) 

 a) Ya/ Yes   b) Tidak/ No 
 
4. Faktor penghalang (jika berkaitan)/ Restraining factors 
 a1. masalah modal/ capital problems  a2. masalah peluang/ Chances 
 a3. Lain-lain (nyatakan)Others _____________________________ 
 
5. Komen dan cadangan: Kaedah untuk membantu meningkatkan sosio-ekonomi 

penduduk melalui pembangunan eko-pelancongan sekitar Taman Negara. 
 Comments and suggestions: Methods to help improve the socio-economic population 

through the development of eco-tourism around National Park. 
 ______________________________________________________________________ 
 
 ______________________________________________________________________ 
 
 

I) Pengusaha Tanaman Kontan/ Cash crop/agriculture/ Farming 
 

1.         Tahun mulai menjadi peladang /Since when become farmer= 19____ 
2. Jenis Tanaman/ type of crops  1= Lada/ Chili  2=Jagung/corn   3=Terong / 

eggplants 4= Lain-lain/others:___________ 
3. Purata keluaran sehari / Average products per day (kg)=_____ 
4.         Purata harga keluaran sehari/Av. product price per day (RM) 1Kg =_____ 
5. Purata hari kerja sebulan/ Average working days per month =_____ 
6. Kos tetap/ Fixed cost   
   a1.  (Water pump) Harga dibeli(Price)  RM___ 

a2.Jangka umur/life span____tahun/Year 
 b1.  (Power spray) Harga dibeli(Price)  RM___ 

b2.Jangka umur/life span____tahun/Year 
c1.  (Pam galas) Harga dibeli(Price)  RM___ 
c2.Jangka umur/life span____tahun/Year  
d1. (Kayu ‘penyokong)Harga dibeli(Price)  RM___ 
d2.Jangka umur/life span____tahun/Year 

 e1.   (Lain -lain)  Harga dibeli(Price)  RM___ 
e2.Jangka umur/life span____tahun/Year 

 
7. Kos semasa / Current cost     
             a.  (Upah membajak) Belanja/musimRM______ (Plowing) 
  b.  (Petrol) Belanja sehari             RM______  (Petrol) 
  b.  (Upah  pekerja) Belanja sehari RM______ (workers wages) 
  c.  (Racun) Belanja sebulan RM______ (pesticides) 
  d.  (Benih)    RM______ (Seeds)  
  e. (Lain-lain)    RM______ (Others)  
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J) Pesawah Padi / Paddy farmer 
 
1.         Jenis pesawah/Type of farmer 

1a=Tanah sendiri/ Own land 1b=Tanah sewa/pajakan/ Rented land 
2. Luas kawasan dikerjakan/ Total area of land =  ________ekar/ acre 
3. Berapa tahun sudah bersawah/ How many years involve =______tahun   
4. Subsidi diterima 2013/ Subsidies recreived=______         
5. Keluaran musim 2013/ Production per season=______ kg/tan         
6. Kos operasi satu musim/ Operation cost per season    
 a. Sewa/Pajak / rent or lease per season            RM________ 
 b. Upah membajak/ plower wages (mesin-3 kali)  RM________  
 c. Beli benih/seeds ________/bag x____bag  RM________ 
 d. Beli racun rumput/herbacideRM ____/liter x ___  liter RM________ 
 e.   Beli racun serangga/pesticides    RM________ 
 f.  Beli baja (tambahan)/ fertilizer    RM________ 
 g. Upah menuai/ harvester wages per day   RM________ 
 h. Lain-lain/ Others      RM________ 
 
7. Anggaran pendapatan/ Estimated income 
  

a. Harga jualan / Sales price RM___________/tan 
 

K) Penoreh getah/ Rubber tapper 
 
1.         Jenis pesawah/Type of farmer 
1a=Tanah sendiri/ Own land 1b=Tanah sewa/pajakan/ Rented land 
2. Luas kawasan dikerjakan/ Total area of land =  ________ekar/ acre 
3. Berapa tahun sudah bersawah/ How many years involve =______tahun   
4. Subsidi diterima 2013/ Subsidies recreived=______         
5. Keluaran musim 2013/ Production per season=______ kg/tan         
6. Kos operasi satu musim/ Operation cost per season    
 a. Sewa/Pajak / rent or lease per season            RM________ 
 b. Upah membajak/ plower wages (mesin-3 kali)  RM________  
 c. Beli benih/seeds ________/bag x____bag  RM________ 
 d. Beli racun rumput/herbacideRM ____/liter x ___  liter RM________ 
 e.   Beli racun serangga/pesticides    RM________ 
 f.  Beli baja (tambahan)/ fertilizer    RM________ 
 g. Upah menuai/ harvester wages per day   RM________ 
 h. Lain-lain/ Others      RM________ 
 
7. Anggaran pendapatan/ Estimated income 
  
Harga jualan / Sales price RM___________/tan 
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L) Pengusaha Ladang Kelapa Sawit 
 

1. Luas kawasan dikerjakan/ Total area of land =  ________ekar/ acre 
2.  Berapa tahun sudah bersawah/ How many years involve =______tahun/Years 
3. Hasil keluaran2013 / Production 2013=_________tan/bulan 
4. Hasil diterima 2013/ revenue 2013 =RM_________/tan 
6. a.  Kos penanaman (penyediaan tanah & anak pokok) = RM____ 
       Cultivation cost (Land preparations and seedling) 

b. Tahun ditanam/ planted year  _________ 
7. Kos operasi purata 2013/ Operation cost 2013 
 a. Merumput/weeding    RM_________ 
 b. Beli racun/ pesticides    RM_________ 
 c. Meracun/ cost positioning   RM_________ 
 d. Beli baja/ fertilizer    RM_________ 
 e. Membaja/ cost fertilizing   RM_________ 
 f. Memetik buah / Picking fruit   RM_________ 
 g. Mengangkut hasil/ Transportation of fruit RM_________ 
 h. Lain-lain/ others    RM_________ 
8. Subsidi diterima 2013/ subsidies received 2013 = RM__________     
 

M) Pengusaha dusun/ Orchard 
  

(i) Dalam kawasan hutan simpan / Forest reserve land 
(ii) Luar kawasan hutan simpan/ Outside forest reserve 
 
1. Jenis spesis tanaman & harga jual (RM/kg)- Type of species and sales price 

 
____________________ RM ______  kg , ______________________ RM _______ kg 
 
____________________ RM ______  kg , ______________________ RM _______ kg 
 
____________________ RM ______  kg , ______________________ RM _______ kg 
 
____________________ RM ______  kg , ______________________ RM _______ kg 
 
____________________ RM ______  kg , ______________________ RM _______ kg 

  
2.  Kos operasi satu musim/ Operation cost per season 

a. Bayaran permit/ permit fee            RM________/musim 
 b. Alatan kerja/ Tools      RM________ 
 c. Beli racun rumput / Herbecides RM ____/liter x ___  liter RM________ 
 d.   Beli racun serangga/ Pesticides    RM________ 
 e.  Beli baja (tambahan)/ Fertilizer    RM________ 
 g. Lain-lain/ Others      RM________ 

 
3.  Anggaran pendapatan/ Estimated income 

a.       Harga jualan RM ____________/kg (Price sales) 

b.       Anggaran hasil_____________/kg semusim (Estimated Product per season) 
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4. Jenis kenderaan yang digunakan/ type of vehicle :_________________ 
 
5. Lokasi pengambilan hasil/ Location 

a) Tempat (nyatakan):____________________________ (Specify name of place) 
b) Jarak dari tempat tinggal ______________________ km (Distance from home) 

  
  

 6.   Pekerja yang terlibat untuk satu-satu trip/ No. Of workers per trips 
 a. Ahli keluarga/family members            ____________orang/person 
 b. Bukan ahli keluarga/non-family members____________orang/person 
 

7.    Jika bukan ahli keluarga berapakah upah yang dibayar untuk satu-satu trip: 
 If non-family members, how much is their wages per trip 

 RM __________________ / seorang/person 
      

N) Nelayan Tasik/Sungai 
 

1. Jenis spesis tangkapan & harga jual (RM/kg) /Species of catches and Price if sell 
 

____________________ RM ______  kg , ________________________ RM _______ kg 

 

____________________ RM ______  kg , ________________________ RM _______ kg 

 

____________________ RM ______  kg , ________________________ RM _______ kg 

 

____________________ RM ______  kg , ________________________ RM _______ kg 

 

____________________ RM ______  kg , ________________________ RM _______ kg 

 

____________________ RM ______  kg , ________________________ RM _______ kg 

 

____________________ RM ______  kg , ________________________ RM _______ kg 
 

2.    Jenis alat tangkapan yang digunakan/ Type of tools used 

  a) Selambau b). Pukat, jenis (nyatakan)___________________________

 c.) Jala  d). Pancing 

 e) Lain-lain _______________________ (nyatakan) 

 

3. Kos alatan /Cost of tools    
 a. Selambau termasuk rumah/pondok (selambau include floating hunt) 

a1. harga bina RM________ a2. jangka umur _______ thn 
      (Building cost)         (Lifespan) 

 b. Pukat/trawl b1. harga beli (Price) RM________ 
    b2. Jangka umur (Lifespan)_________ bulan @ tahun 
 c.  Jala/net c1. harga beli (Price)RM ________ 
    c2. jangka umur (Lifespan) __________ bulan @ tahun 
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 d. Pancing d1. harga beli(price) RM _________ 
      (Fishing rod) d2. jangka umur(Lifespan) ___________bulan @ tahun 
 

4. Jumlah pengambilan hasil _________________ kg/trip/bulan  
(Number of catches) 

  
5. Jenis kenderaan yang digunakan :______________________ 

(Mode of transportation) 
6. Lokasi pengambilan hasil (Fishing location) 

a. Tempat (Htn. Simpan, Tnh. Kerajaan atau Hakmilik):__________ 
Location (PRF/Stateland/Alienated land) 

b. Jarak dari tempat tinggal __________________ km 
(Distance from house) 

     7. Bilangan pekerja yang terlibat untuk satu trip (Number of workers per trip) 
 1. Ahli keluarga (Family)  ____________________ orang 
 2. Bukan ahli keluarga (Non-family) ____________________ orang 
 
8. Jika bukan ahli keluarga berapakah upah yang dibayar untuk satu-satu trip: 

(If non-family, how much the wages per trip) 
 RM __________________ / seorang (person) 
      
9. Jangkamasa kerja ketika pengambilan hasil (untuk setiap trip) 

(Fishing duration per trip) 
 1. Keluar menangkap ikan (Time start) (jam) _______________ 
 2. Balik (Time end) (jam) _______________ 
 

 

O) SUMBER-SUMBER PENDAPATAN PURATA BULANAN 
SEMUA AHLI ISIRUMAH (IAITU SEMUA PENDAPATAN 
AHLI-AHLI YANG TINGGAL BERSAMA SAHAJA). 

 (Average household monthly income sources ) 
 
 Pendapatan Tunai      Purata Pendapatan Sebulan Bagi 2013 
 (Cash income)     (Average monthly income for 2013) 
 
1. Makan gaji (a) Kerja resort (Resort) RM________Sebulan/month 
 (Received (b) Pekerja kilang lain (Factory)RM_____Sebulan 
 Salary)  (c) Kakitangan kerajaan (Gov)RM_________Sebulan 
   (d) Kakitangan swasta (Private)RM________ sebulan 
   (e) Pekerja kontrak (Contract) RM________Sebulan 
   (f)  Lain-lain (Others) RM_________Sebulan 
 
2. Hasil jualan/ (a) Mencari hasil hutan (forest resources) RM_____Sebulan 
 kerja sendiri (b) Jualan hasil kraftangan (handcraft)RM______Sebulan 
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 Bussines  (c) Pengusaha chalet (Chalet operator) RM _____sebulan 
   (d) Pengusaha homestay(homestay operator RM___sebulan 
   (e) Pemandu bot (Boatman) RM _____sebulan 
   (f) Pemandu pelancong (tourguide)RM_____sebulan 
   (g) Kedai runcit/makan(grocery/restaurant)RM___sebulan 
   (h) Berniaga (bussines)  RM______________sebulan 

 (i)  Lain-lain (others) RM______________Sebulan 
 
3. Hasil Pertanian (setelah tolak kos)    
 Agriculture (a)  Penanam tanaman kontan (cashcrop)RM____Sebulan 
   (b) Tanaman padi (paddy)RM______________Sebulan 
   (c) Penoreh getah (rubber tapper)RM_______Sebulan 
   (d) Pengusaha kelapa sawit (oilpalm)RM_______Sebulan 
   (e) Hasil dusun(orchard)    RM______________Sebulan 
   (f) Menghasil ikan (fisherman)RM_________ Sebulan 
   (g) Hasil ternakan(cattles)RM______________ Sebulan 
   (h)  Lain-lain(others) RM______________Sebulan 
 
4. Kiriman wang oleh ahli keluarga yang bekerja di tempat lain.  
 (Remittances from family members) 

RM______________Sebulan/Month 
5. Lain-lain pendapatan (berniaga, bonus, sewa, faedah dan lain-lain)  
 (Others income sources (bussiness, bonus, rent, interest, etc.) 

RM______________Sebulan/Month 
 

Pendapatan Bukan Tunai. (Inkind income) 
 
6. Makanan ikan / udang / ketam yang dihasilkanRM ______________ 
 Food catches (fish, shrimp, crab) 

(Nilai wang jika beli di pasar tolak kos) /Price if we sale, deducted cost 
 
7. Makanan dari hasil tanaman / ternakan   RM ______________ 
 (Food from rearing/ own farm) 

(Nilai wang jika beli di pasar tolak kos) /Price if we sale, deducted cost 
 
8. Tinggal di rumah sendiri (Live own house) RM ______________ 
 (Nilai bulanan jika di sewa)/Value if rented   
 
9. Guna air bukit/perigi (well/hill water supply)     RM ______________ 
 (Nilai wang jika guna saluran paip kerajaan)/price if piped  
                 (2-4 orang =RM10, 5-8=RM15, >8=RM20)  
 
10. Lain-lain(others)     RM _____________ 
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P)  Pemilikan Harta Isirumah (household property ownership) 
 
 (1) Kereta/Car    1 = Ada/Yes 0 = Tiada/No 
 (2)   Motorsikal/Motocycle  1 = Ada/Yes 0 = Tiada/No 
 (3) Radio     1 = Ada/Yes 0 = Tiada/No 
 (4) T.V     1 = Ada/Yes 0 = Tiada/No 
 (5) Video     1 = Ada/Yes 0 = Tiada/No 
 (6) Astro     1 = Ada/Yes 0 = Tiada/No 
 (7) Peti sejuk/Referigerator  1 = Ada/Yes 0 = Tiada/No 
 (8) Mesin basuh/ washing machine 1 = Ada/Yes 0 = Tiada/No 
 (9) Telefon/telephone   1 = Ada/Yes 0 = Tiada/No 
 (10) Telefon bimbit/ handphone  1 = Ada/Yes 0 = Tiada/No 
 (11) Kipas eletrik/electric fan  1 = Ada/Yes 0 = Tiada/No 
 (12) Bot/boat    1 = Ada/Yes 0 = Tiada/No 
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Note 7 – Using SPSS software 

1.0 GETTING STARTED WITH SPSS 

 

The SPSS package is a powerful and user-friendly statistical analysis tool . It provides  

a simple point and click or drag interface for statistical analysis. It has a DATA 

EDITOR, which is a spreadsheet that allows you to enter data easily. Statistical 

analysis results are displayed in the OUTPUT window and tables and charts can be 

copied and paste easily into other programs such as Word or Power-point for 

documents and presentations. 

 

To start SPSS, left click on the Start button (at the lower left corner), select Programs, 

SPSS for Windows and SPSS 18.0 for Windows. 

 

The SPSS windows dialogue appears and provides a list of tasks that you can do.By 

default, the task is set as “Opening an existing data source”. 

 

 

Click on the OK button and the Open Data dialogue box appears and provides a list 

of available SPSS data sets in the SPSS folder. 
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Select required data example the “TRAINING “ from the list of SPSS files and click 

on the Open button. If the data is save in SPSS format, it will appear extension 

“.sav”.  

 

 

The DATA EDITOR and the OUTPUT windows will appear. Select the DATA 

EDITOR window. 
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At the top right corner of the DATA EDITOR window, there are three buttons for the 

following tasks: 

 Minimize         Left button with a dash (-) 

 Maximize      Middle button with a square () 

 Close                Right button with a cross (x) 

Maximize the data window by clicking on the middle button with a square. 

 

You can now get a full view of the data in the Employee data file. 

SPSS data files are saved with the extension “.sav’ 
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The SPSS  main windows are listed below: 

Data Editor A spreadsheet for defining variables, entering and editing 
data. 

Output Viewer  Displays statistical results, tables and charts. 
Output can be saved as an output file for later use. 
Output can be copied and paste into other programs such as 
Word and Power-point. 

Pivot Table Editor Output displayed in tables can be edited. Rows and column 
can be interchanged. 

Chart Editor Charts can be edited. Allows changes such as colour, font and 
chart types. 

Text Output Editor Allows text in output viewer to be edited. 

Syntax Editor Allows saving SPSS syntax and running syntax commands 
during an SPSS session. 

Script Editor Allows advanced users to customize and automate SPSS tasks 
by creating and modifying scripts within the program.   

 

The DATA EDITOR allows you to define variables, enter or edit data easily. 

At the left bottom corner of the DATA EDITOR window, there are the Data View 

and the Variable View tabs. 

 

 

 

 

 

To view 

data 

To view information 

on variables 
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Click on the Variable View tab and information such as variable name, type, label 

and declaration of missing values are displayed. 

 

 

 

Click on the Data View tab to return to the DATA EDITOR Window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Variable 

Name 
Variable 

Type 

Variable 

Value 

Variable 

Measure 
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The File menu in DATA EDITOR has a list of tasks such as creating New (Data, 

Syntax, Output or Script), Open (Data, Syntax, Output or Script), Close, Save, Save 

As (to different location),  Export to Database (dBase, Excel or MS Access), and 

listing of Recently Used Data or Recently Used Files.  

 

 

The Edit menu provides tasks such as Cut, Copy, Paste, Clear, Insert Cases, Insert 

Variable, Find (to find data for a particular variable), Go to Case (to locate certain 

Case Numbers or observations) and Options (to change default settings)
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The View menu allows changing the font style, remove grid lines and display 

variables or value labels for coded variables (such as f = Female, m = Male). 

 

 

 

The Data menu  provides a list of tasks such as Copy Data Properties (copy selected 

variable and data from other data sets), Sort Cases, Merge Files, Split File and 

Select Cases.  
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The Transform menu allows you to Compute (create new variables such as sum, 

ratio or log), Recode, Automatic Recode (recode several variables at once), Visual 

Binning (create bins for interval variables), Rank Cases and Replace Missing 

Values. 

 

 

The Analyze menu provides a list of statistical analysis such as Descriptive Statistics 

(frequencies and cross-tabulations), Compare Means (Independent-Samples T-test, 

Paired-Samples T-test, ANOVA), General Linear Model, Correlation, Regression 

and Non-parametric Tests. 
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The Graph menu enables you to create bar charts, pie charts, line charts, boxplots 

and  histogram using Chart Builder,  Interactive or Legacy Dialogs. 

 

 

The Help menu allows you to search information under Topics, learn more on  how 

to use SPSS using Tutorial, Case Studies  or Statistics Coach. 
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2.0 CREATING SPSS DATA FILES 

 

The SPSS DATA EDITOR is a spreadsheet that allows you to enter data easily. 

Click on the File menu, select New and Data and the SPSS DATA EDITOR window 

appears. The Untitled1[DataSet] at the top left corner indicates that this is a new file 

and no filename has been given. 

 

 

Click on Variable View tab to define the variables. 

To define the first variable (i.e. gender), left click on the first column in the first row 

under the Name column and type in gender.  
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Move the cursor using the left arrow  on the keyboard to the Type column. 

Since gender is coded as “1” and “2”, it can be declared as Numeric. If gender is 

coded as “m’ and “f” then you will need to select String. Use the default Numeric 

type and click on OK. 

 

We will use the default setting for Width. 

 

In the Decimals columns, the default decimal place is 2. Decrease the decimal to zero 

as gender is a categorical variable and not measured on a continuous scale. Move the 

cursor using the left arrow  on the keyboard to the Label column and type gender. 

Next, move the cursor using the left arrow  on the keyboard to the Values column. 

Click on the small grey square button and the Value Labels dialogue window 

appears. Type 1 in the Value box. Next, type male in the Label box and click on Add 

button.  
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Repeat and Type 2 in the Value box. 

Then, type female in the Label box and click on Add and OK 

 

 

 

1. Right Click 

Values column 

2. Type “1” & 

Label as Male 

3. Click Add 

4. After Done Add 

Values, Click OK 
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Continue defining the other variables as listed below. 

Name Type Label Values 

gender numeric Gender 1=male 
2=female 

age numeric Age 

1=21-30 
2=31-40 
3=41-50 
4=above 50 

education numeric Education attainment 

0=Tiada 
1=Sek Ren 
2=Sek Men 
3=Tgkt 6 
4=Kolej &U 

A1 numeric Land for agriculture 

1=Yes 
0=No 
 

 
 

A2 numeric Fishing 

A3 numeric Animal hunting 

A4 numeric Herbs for medicine 

A5 numeric Rattan harvesting 

A6 numeric Water supply for agriculture 

A7 numeric 
Forest resources for 
handcraft 

A8 numeric Wildfruit harvesting 

A9 numeric Bamboo harvesting 

A10 numeric Honey harvesting 

 

 

2.1    Defining  Variables Rules 

 Must begin with a letter 

 Cannot end with a full stop or underscore 

 Blanks, space and special characters (such as ?. “.!, *) cannot be used. 

 Duplication of variable names is not allowed. 
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The Variable View window with all variables defined is shown below: 

 

 

Click on the Data View button at the lower left corner to get back to the DATA 

EDITOR window. 

Enter the data for the first five respondents as shown below: 
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Click on the File menu and select Save As. 

The Save Data As dialogue window appears 

Under Save in, select the location (or folder) where you want to save your file by 

clicking on the down arrow . 

 

 

 

Type in survey in the File name box below the list of SPSS data files. 

By default, the Save As type is SPSS (*.sav) for SPSS data file. 

In this example, the survey.sav data is saved in the FRIM folder. 
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2.2    Importing Excel Files 

This section illustrates how to import Excel data files into SPSS. 

Go to the File menu, select Open and Data. 

 

 

From the Open Data dialogue window, under Look in, click on the down arrow   

and select the folder FRIM. 

Next, under File of type, click on the down arrow  and select Excel (.*xls). 

 

 

Select the WORKSHOP.xls data in Excel format and click Open. 
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In the Opening Data Source dialogue window, under Worksheet window, click the 

down arrow  and three Excel worksheets will be displayed. Select the first 

worksheet WORKSHOP ([A1:M1]. 

 

Click OK and the data appears in the SPSS DATA EDITOR window. 

Click on the File menu, select Save As. In the Save As In dialogue window, under 

File name, type in WORKSHOP1 and click Save. 
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Repeat the whole process and import in the second Excel worksheet  and save it as 

WORKSHOP2. 
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This section illustrates how to merge three SPSS data file into one file. 

 

Open the WORKSHOP1 SPSS data file using File, Open Data. From the Data menu, 

select Merge files and Add Cases. In the dialogue window Add cases to 

WORKSHOP1, under An Open data set, select WORKSHOP2 and click Continue. 

Note that you will have to click on the An External SPSS data file button and 

Browse to locate WORKSHOP2 if it is not an open data set. 
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In the Add Cases  from WORKSHOP2 dialogue window, make sure that all the 

variables are listed in the Variables in Active data set box. Click OK and the 73 

observations in WORKSHOP2  will be included  into the WORKSHOP1 SPSS data 

set. 
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Click on File, select Save As and and type WORKSHOP_merge in the File Name box. 

This SPSS data set contains observations from all three data sets. 
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3.0 DESCRIPTIVE STATISTICS AND CREATING CHARTS 

 

Quantitative analysis should always start with some descriptive statistics and charts 

before moving on to inferential statistics which involves modeling and hypothesis 

testing. Simple descriptive statistics involve reporting the mean or median and 

standard deviation of continuous variables, and the frequency distribution and 

percentages for categorical variables. Charts are informative visual aids for 

summarizing results and makes report looks interesting. 

 

3.1   Descriptive Statistics 

This section illutrates obtaining frequency distribution for catregorical variables and 

descriptive statistics for continuous variables using SPSS. 

 

3.1.1  Obtaining frequency distribution 

Open the orangasli.sav file  

Click on Analyze and select Descriptive Statistics and then Frequencies. 

. 

 

.   

The Frequencies dialogue box appears. Select the variable “Name of Village” and 

click on the middle button  to move it to the Variable(s) box. 
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The SPSS output is shown below: 

 

Statistics 

Name of village  

N Valid 239 

Missing 0 

 

 

Kg 

  

Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 1 Sg Raba 78 32.6 32.6 32.6 

2 Sg Banun 39 16.3 16.3 49.0 

4 Desa Permai 52 21.8 21.8 70.7 

5 Desa Damai 42 17.6 17.6 88.3 

6 Ria 28 11.7 11.7 100.0 

Total 239 100.0 100.0  

 

Note that since there are no missing values the Percent and Valid Percent values are 

the same. 
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3.1.2  Descriptive statistics 

Open the Employee Data.sav file  

Click on Analyze and select Descriptive Statistics and then Descriptives. 

In the Descriptives window, select teh variable ‘salary’ and ‘salbegin’ and move them 

into the Variable(s) box. 

 

Click on the Options tab and the Descritive:Options dialogue window appears. 

By default the boxes for Mean, Std. Deviation, Minimum and Maximum are already 

checked. Under Distribution, click on the Skewness and Kurtosis boxes. 

Then, click Continue and OK.  

The descriptive statistics results will appear in the OUTPUT window. 
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3.2    Creating Pie Charts 

 

Click on the Charts button. Select Pie Chart. Under Chart Value, then select 

Percentage. 

 

 

 

Click on Continue and then OK. 

The pie chart will appear in the OUTPUT window. 

 

 

Double click on the  pie-chart to activate the Chart editor 
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Double click again on the pie chart in the Chart Editor window and the Properties 

dialogue box appears. Click on Depth & Angle. 

 

 

 

Click on the 3-D radio button.Then, click on Apply and Close. 
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Double click on the 3-D pie-chart. From the Elements menu select Data Label Mode 

and click on each slice of the pie-chart to put in the  percentage value. 

 

 

 

Click on Elements and Data Label Mode again to switch off the Data Label Mode. 
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Click on the Minimize button to return to the Output window. You have now 

created a 3-D pie-chart with percentage values for each segment. 

 

 

 

 

3.3    Creating Bar Charts 

Click on Graphs, select Legacy Dialogs and Bar. 

 

 

 

The Bar Charts dialogue window appears. Click on Simple and under Data in Chart 

use the default “Summaries for groups of cases”. Click on Define. 
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In the Define Simple Bar:Summaries for Groups of Cases, select Gender and move 

it to the Category Axis box. Click on the % of cases  radio button and then click OK. 

 

 

 

The simple bar chart for gender will appear in the OUTPUT  window. 
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To create a 3-D simple bar chart, double click on the bar chart and the Chart Editor 

window appears. Double click on one of the bars and from the Properties dialogue 

box, click on Depth & Angle. Click on the 3-D radio button and then click Apply.  
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The 2-D simple bar chart changes to a  3-D chart. Click on Elements and select Data 

Label Mode.  

 

 

Click on each of the bar and the percentage value will appear.  

 

 

 

Close the Chart Editor window by clicking on the Minimize button. to view the 3-D 

bar chart in the OUTPUT window. 
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You can click on the bar chart in the Output window  to select it. 

Then, click on the Edit menu, select Copy and Paste the bar chart into a Word 

document or power-point slide. 

 

3.4    Creating Clustered Bar Charts 

 

Click on Graphs, select  Legacy Dialogs and Bar. 

The Bar Charts dialogue window appears. Click on Clustered and under Data in 

Chart  use the default “Summaries for groups of cases”. Click on Define. 
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In the Define Clustered Bar:Summaries for Groups of Cases, select Marital Status 

and move it to the Category Axis box. Then, select Gender and move it to the Define 

Clusters by box. Click on the % of cases  radio button and then click OK. 

 

 

 

The clustered bar chart for gender clustered by marital status appears in the 

OUTPUT  window. 
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To create a 3-D clustered bar chart, double click on the bar chart and the Chart Editor 

window appears. Double click on one of the bars and from the Properties dialogue 

box, click on Depth & Angle. Click on the 3-D radio button and then click Apply. 

 

 

 

The 2-D simple bar chart changes to a  3-D chart. Click on Elements and select Data 

Label Mode.   
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Click on each of the bar and the percentage value will appear.  

 

 

 

Close the Chart Editor window by clicking on the Minimize button to view the 3-D 

bar chart in the OUTPUT window 

 

 



75 | P a g e  

 

 

 

3.5    Creating Stacked Bar Charts 

 

Click on Graphs, select Legacy Dialogs and Bar. 

The Bar Charts dialogue window appears. Click on Stacked and use the default 

“Summaries for groups of cases”. Click on Define. 
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In the Define Stacked Bar:Summaries for Groups of Cases, select Gender and move 

it to the Category Axis box. Then, select Marital Status and move it to the Define 

Stacks by box. Click on the % of cases  radio button and then click OK. 

 

 

 

The bar chart for gender  stacked by marital status appears in the OUTPUT  

window. 
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To create a 3-D clustered bar chart, double click on the bar chart and the Chart 

Editor window appears. Double click on one of the bars and from the 

Properties dialogue box, click on Depth & Angle. Click on the 3-D radio button 

and then click  Apply. 

   

 

The 2-D simple bar chart changes to a  3-D chart. Click on Elements and select 

Data Label Mode.   
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Click on each of the bar and the percentage value will appear.  

 

 

Close the Chart Editor window by clicking on the Minimize button to view the 3-D 

bar chart in the OUTPUT window. 
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3.6    Creating Simple Boxplots 

 

Click on Graphs, select Legacy Dialogs and Boxplot. 

 

 

The Boxplot dialogue window appears. Click on Simple and use the default 

“Summaries for groups of cases”. Click on Define. 
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In the Define Simple Boxplot:Summaries for Groups of Cases, select Age and move 

it to the Variable box. Then, select Gender and move it to the Category Axis box. 

Then, click OK. 

 

 

The simple boxplot for Age appears in the OUTPUT  window. 
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The dark horizontal line in the box, represents the median of age for each gender.The 

boxplots show that the median age for male is higher than female. The long whiskers 

indicate  that the distribution of age is skewed to the right for each gender.The small 

white circle indicates there is an outlier in the female group.  

 

3.7   Creating Clustered Boxplots 

 

Click on Graphs, select Legacy Dialogs and Boxplot. 

The Boxplot dialogue window appears. Click on Clustered and use the default 

“Summaries for groups of cases”. Click on Define. 

 

 

 

In the Define Clustered Boxplot:Summaries for Groups of Cases, select Age and 

move it to the Variable box. Then, select Name of Village and move it to the Category 

Axis box. Then, select Gender and move it to the Define Clusters by box and click 

OK. 
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.  

 

The clustered boxplot of Age for every village will appear in the OUTPUT  window. 

 



Note 8 – Using R software 

• What is R and Why use R 
• Installation of R 
• Start R 
• How to use R 
• Some of my applications 
• Try using R now 
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What is R and Why use R 

• R is a language and environment 
for statistical computing and 
graphics. It is superior to many 
other graphics and analysis 
packages commonly used, and has 
a very wide range of statistical 
analysis and data plotting 
functions. 

• R is free. 
• R is used in academic reseach, 

business and industry.  
• It was said that there are at least 2 

million users. 
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• R is effective and  is an 
independent platform.  R can run 
in Windows, Mac, Linux. This is 
very important for 
communicating with different 
system users. 

• R has many (maybe too many) 
help resources.  There is 
absolutely nothing like it. There 
are many online help resources 
both from r-project.org and from 
many specific lists and interest 
groups, even though sometimes it 
seems difficult to choose.  

•  R makes excellent graphics. The 
command-line interface is much 
better for using, learning and 
teaching.  Users can post, 
reproduce  and save the 
commands conveniently. 85 



• R is command-oriented: Users 
normally type commands, and the R 
responds interactively to these 
commands. And many packages are 
developed by about 20 core team 
members and many other 
contributors. 

• Highly extensible, with over 3500 
user-contributed packages available 
and still growing. 

• Open source. Bugs found, reported 
and corrected. You can write your 
own packages.  

• Unlimited possibilities. 
• The basic R system, and contributed 

packages, are available from the 
Comprehensive R Archive Network 
(CRAN) at http://cran.r-project.org/ 

• Home page for R:  http://www.R-
project.org/ 
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Start R 
• Go to cran.r-project.org; 
• Under “Download and Install R”, 

click on the “Download R for 
Windows” link; 

• Under “Subdirectories”, click on the 
“base” link; 

• Save R file somewhere and start it; 
• To Install R by clicking “next”……; 
• When asked 32-bit or 64-bit, you 

need check your computer 
operating system (os); 

• After finishing the installation, check 
if there is an “R” icon on the 
desktop of the computer. If so, start 
it by double-clicking; 

• Or, start it from the start menu of 
programs. 
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How to use R 
• You can write commands and 

calculate directly at R Console, but 
editing “script” is convenient. 

• Simple output is prefixed by [1]. 
• <- is the assignment operator; in 

the illustration, c <- 1:3, the vector 
of integers from 1 to 3 is assigned 
to a variable named x. 

• lower- and upper-case letters are 
different. 

• To download and install a package: 
install.packages("") 

• Packages are introduced by 
library(“   ”), and this introduction 
needs to be done every time 
before using. 
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Objects 
• All variables (scalars, vectors, 

matrices, etc.) created by R are 
called objects. In R, we assign 
values to variables using an arrow 
“less than” + “minus”: “<-”. 

• There are several possible 
different types of objects in R, 
including scalars, vectors, 
matrices, arrays, data frames, 
tables, and lists. 

• List objects: ls() 
• Remove objects: rm(“object”) 
• Object, function, arguments 
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Help for R 
• help(package="base") # List package 

contents 
• ?data.frame # help on a specific task 
• ?Syntax # help on a general topic 
• news(package="ggplot2") # details 

of recent changes 
• demo(“graphics") # demonstrate 

graphics 
• browseVignettes() # view index of 

vignettes in web browser 
• See documentation links at 

http://www.r-project.org for 
manuals, 

• Wiki, R journal, books etc. 
• CRAN task views: http://cran.r-

project.org/web/views/ 
• R bloggers, aggregated at 

http://www.r-bloggers.com/ 
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Applications of R 

• Wherever there is a calculation, 
data analysis, graphics…… 

• Some of our experiences: 
    Panel data analysis  
    Cluster analysis 
    Mixed model estimations 
    Dealing with demand elasticities 
of GDP and price on forest products, 
drivers of deforestation, forecasts of 
forest areas and forest carbon stock, 
etc. 
                    Let’s TRY NOW! 
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Thanks for the great contributions from R 
developers and all other contributors! 
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